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Section 1 - Change log

* v4.1.0 3/3/2025

o Added event and property for power meter connection status and expose
via automation interface
= AutomationPowerMeterEvents.OnStatusChange

m |[APowerMeter.IsConnected

o Added log events when a power meter connects or disconnects to the data
server logs.

o Changed the previous enumeration AutomationSavelLoadStatus and
renamed to ASaveloadStatus in the Spiricon.Automation namespace. This
change brings it in line with the naming convention for other
enumerations in the interface. Note: This is a breaking change and requires
recompilation of automation clients.

o Changed EA1 to automatically reconnect to the previously connected EA1
power meter.

o Changed EA1 discovery broadcast via UDP to not send if currently
connected to a power meter.

o Changed EATEnumerator automation class to work either as a standalone
enumerator or when used by BeamWatch.

e v4.0.0 07/28/2023

o Added support for BW-NIR-130 and BW-PLUS-45
o Added support for Windows 11

o Added D4sigma (Iterative) measurement method as a new Beam Width
Basis

o Added events to the automation interface for wavelength range changes
when connected to a BW-PLUS device

o Added ability to clear out the Frame Buffer



o Added ability to clear out all data

o Added option to load only data from a file and not the setup

o Added ability to change the playback rate when playing through a data file
o Added tooltips to all controls and revised existing tooltips for clarity

o Added lens type and model designation to the connected device name.
BW-NIR-155 BeamWatch Original Low Mag

BW-NIR-55 BeamWatch Original High Mag
BW-NIR-130 BeamWatch Standard Low Mag
BW-NIR-45 BeamWatch Standard High Mag
BW-PLUS-45 BeamWatch Plus High Mag
BW-NIR-50-AM BeamWatch AM

o Changed frame buffer to present frames in chronological order

o Changed loading data files to automatically play through all frames during
load so statistics and charts are populated.

o Changed location of Beam Width Basis selection from the Results Settings
Dialog to the Results toolbar

o Changed location of statistics reset from the Results toolbar to the Data
ribbon

o Changed the Profile colors in the Measured Caustic Display to match the
profile colors in the 1D Profile Display and changed the curve fit to the
measured beam widths

o Fixed some filtering algorithms to perform more consistently in a broader
range of scenarios. Users may see a <1% change in calculated results with
improved accuracy.

o Fixed an issue where the distance results were calculated incorrectly when
using units other than millimeters

o Fixed an issue where the Measured Caustic Display only displayed the pre-
processed data.
= Note that widths are taken before the final filter to display more of the
complete caustic. This causes the 13.5% of Peak and the D4sigma
widths to appear identical.

o Fixed an issue where double clicking on a data file would not load the
data.

o Fixed an issue where languages that require double-byte character
localizations could not be used in the data file name due to a restriction
introduced by a third-party component

o Fixed an issue where the Measured Caustic Display would not always
update properly when changing the Beam Width or Distance units



o Fixed an issue where the 1D Profile Display would not update to the
selected Beam Width units

o Deprecated IAProgrammableSettings.Wavelength and
IAProgrammableSettings.LaserDistance in automation interface, in favor of
IAWavelLength and IALaserDistance.

o Removed the ability to change the wavelength when viewing a loaded data
file

o Removed the ability to change the Frame Buffer size when viewing a
loaded data file

e v3.4.2 4/14/2023

O

Fixed an issue where a memory leak could occur when using the Export
interface via automation.

O

Improved memory buffer re-use as frames are collected and processed
which reducing churn in the memory profile of BeamWatch.

Fixed a crash caused by Microsoft .NET Framework Update KB5020623 that
affected some dropdown style menus/tooltips such as Source
m This affected the Source, Power Meter, and Theme dropdown controls.

O

O

Updated to Spiricon Driver Manager v1.49.0
e v3.4.11/31/2022

o Fixed an issue where the Play/Pause button would intermittently be stuck
after pausing data acquisition.

o Fixed issues where the connection to the BeamWatch Integrated would fail
if the EA-1 power meter wavelength was set to NIRS.

o Fixed an issue where the calibrated offset for the BeamWatch hardware
was not applied when loading data or connecting to the hardware in select
environments.

o Added scrolling to the ribbon group visibility dialog to show all ribbon
group options.

o Updated to Spiricon Driver Manager v1.46. Includes the Lumenera v6.90
drivers for the BeamWatch AM.

® v3.4.0 7/30/2021

o Added a camera selection list for users with multiple cameras. The list
displays the serial number and IP address, if applicable.

o Added the ability in automation to get a list of available cameras by serial
number. Automation users can then connect by serial number.

o Added a power meter selection list for users with multiple power meters.



o Added the ability in automation to get a list of available power meters by
serial number. Automation users can then connect by serial number.

o Added the ability to configure power sensor wavelength and power scale
ranges defined by the specific sensor.

o Added a source info display to the Source ribbon. This will display the IP
address and serial number of a connected data source, power meter, and
power sensor, as applicable.

o Added the IP addresses to the status bar for all applicable connected
devices.

o Removed centroid average result from the application.
o Automation documentation update

o Fixed memory leak associated with logging via automation.
e v3.3.14/17/2020

o Fixed an issue that displayed "No Source Connected" when in fact there
was a device connected and collecting frames.

o Fixed an issue with the EA-1 not connecting to power sensors with discrete
wavelength settings.

o Added ability to configure the EA-1 using UDP via the automation
interface.

¢ v3.3.0 1/22/2020

o Added a warning in the alert bar if data collection is running and the
shutter is closed.

o Changed the camera overheat warning to appear at a lower temperature.

o Added the capability to set the IP address of the GigE camera inside the
BeamWatch unit via the automation interface.

o Added support for the EA-1 Ethernet Adapter for power measurement.

o Added the capability to set the IP address of the EA-1 device via the
automation interface.

o Added a saturation check to the status bar annunciator that will indicate if
saturation occurred at the waist.

© Added an alignment check to the status bar annunciator that will indicate
if the beam is out of optimum alignment.

o Added support for TIFF data in the bwData file output, enable via the
options section of the main menu.
m Data is stored using the Gray32bppFloat pixel format

o Fixed a bug that could cause loading of data files to fail.



e v3.2.19/27/2018

o Corrected a bug that caused BWAM units to lose license and
configuration. This occurred primarily when the BWAM power was
removed before closing the software.

o Changed architecture of joule counter system to write information to disk
instead of camera memory. This prevents excessive writing to flash
memory.

o Corrected a bug that prevented the Focal Plane Region overlay from
appearing on BeamWatch hardware.

o Corrected a bug that caused the Focal Plane Region overlay to not draw if
the software was not started with the Alignment Crosshair setting already
selected.

o Corrected a bug that occurred when starting the software that caused the
system to receive images but fail to produce results.

o Corrected a bug that applied improper camera gain in BeamWatch
hardware.

e v3.2.0 7/20/2018

o New average results for Waist Width and Location, Focal Shift, Centroid,
Cursor to Waist, Center to Waist, Cursor Width, Rayleigh Length, M2, K,
BPP and Divergence.

o Highlighting notification for all results that may be suspect when an M2
measurement less than one (1.0) is calculated.

o Added ability for determining a suitable exposure setting.
o Added 13.5% of peak as a selectable beam width basis measurement.

o Ability to filter frames maintained in the frame buffer based on ISO or
SNR/Caustic fit criteria.

o Connection to devices without external power prohibited to avoid internal
memory corruption and loss of licensing. Informative dialogue box added
to inform user.

o Additional Improvements:
® GPIO communication for enhanced response for fan and shutter
control.

m Depth of focus for various configurations and lenses.
= Connection speed.

m Calculations for accuracy of measured results.

e v3.1.2 5/22/2018



o Maintenance release to enable demo licensing of BeamWatch.

o Corrected a misleading error message that implied that the camera
needed licensing when in fact the true problem was an addressing
mismatch between the BeamWatch and the PC's Network Interface. This
update obsoletes Engineering Bulletin 0034.

e v3.1.1 4/23/2018

© Maintenance release to maintain compatibility with other OSI software.
You will need this release if you plan to install BeamWatch on a computer
that also has current versions of BeamGage, BeamMic, ModeCheck, or
BeamSquared.

e v3.1

o Added the full BeamWatch Additive Manufacturing (BWAM) feature set.
m Connection to BWAM hardware for control of shutter and fan.

= Power meter and energy absorption monitoring.

m Additional results for BWAM use.
o Added automation support for access to beam width by location.
o Added automation support to retrieve 2D image.
o Added automation support for BWAM specific features.

© Added improvements to logging.
= Enable appending when the log file already exists.

m Add a new header for each data set.
m Keep logging enabled if in continuous mode.

o Improved frame buffer management.
= Prevent mixing of live data with previously loaded file data.

o Focal reference position is not set until a caustic fit is obtained in both
axes and the signal to noise ratio of the image is adequate.

e v3.0

o Upgraded PGR drivers to 2.11.164

o Added PDF report.

o Improved fit and M2 calculations.

o Beam width measurements now use D4 sigma method.

o Waist Width, Waist Location, Ellipticity, Rayleigh length, M2, K, BPP,
Divergence, and Centroid Calculations are displayed as ISO when possible.

o Added Beam Tilt X/Y measurement, and the caustic fit is drawn along the
beam tilt in the 2D display.



o 3D display changed to show slices through the beam.
o Added 2D display zooming.

© Focal shift markers include tooltips.

o Reduced file loading and application startup time.

o Chart data can be exported to CSV.

o Continuous attempts are made to restore lost connections to BeamWatch
units.

o Automation control to save and load data.
o222

o Added an automatic feature to suspend computer sleep while the program
is running. This prevents data loss when taking measurements over long
periods of time.

o v2.2.1

o Enabled a utility for factory calibration, for internal use. It is not accessible
to users.

e 220

o Full Windows 10 compatibility

o Image processing improved to increase the SNR in noisy and low intensity
environments.

O

Beam Area Height expanded from 60% to 80% for enhanced measurement
accuracy.

O

Gain range minimum increased to prevent early saturation of the image.

O

Enhanced application logging for diagnostics

O

Renamed application titles to make them easier to identify in Windows
Task Manager

o Fixed issue where the caustic fit failed to draw after loading a file.
e v2.1.0

o 3D Beam Display
m Added ability to view 3D display of beam in dual axis mode only
o Charts
m Added ability to individually chart results
o Dual Axis Offsets
m X and Y calibration offsets are now used to adjust the x and y images.
This corrects the cursor and ellipticity calculations.



o 1D Profile
= Beam Width locations were changed to be centered on the raw
centroid rather than a fitted centroid.

= When auto-scale is not selected, the Y axis max will still grow to fit all
the data.

o Window positions and sizes now persist globally. They are no longer saved
and loaded from the data files.

e v2.0.0

o Introduced new user interface
m Supports dual axis BeamWatch units

= Windows can be moved, resized, undocked, or hidden
m |ndividual ribbon tabs can be hidden or shown

o Results Window
» Added the following results:
m \Waist to Cursor — Distance between waist location and the cursor

= \Width at Cursor — Beam width at the cursor location

= Rayleigh Length — The distance from the waist where the beam
cross sectional area is 2 times larger than at the waist

m K- 1/Propagation Ratio (M2)

® Frame Information results (Frame ID, Timestamp, Exposure, Gain)

Added Max, Min, and Sample size statistics

New Statistic modes: 1) Number of Frames and 2) Running Window
and 3) Time

New Option to reset statistics on Start

Units can be changed for individual results
m Results and statistics can be hidden

o 2D Beam Display
m Added Option to display the beam horizontally or vertically

= OSI rainbow palette is the only palette available

= Removed counts, and micron location description at the bottom of
the 2D Beam Display Window

© 1D Profile Window
= Profiles now have an auto scale option instead of the normalized
option
m Beam Width markers can be hidden

o User Setup
= User entered "Laser Position" was changed to "Laser Distance". Laser



Distance is much simpler and is the distance from the laser source to
the top of the BeamWatch.

m Magnification factor no longer needs to be entered into the software.
It is read from the BeamWatch unit.

o Introduction of a frame buffer with user configurable size.
® The record button was removed because it is not needed with the
frame buffer. The data can be saved and played back at any time.

© Logging
= New logging options: 1) Number of Frames and 2) Time.

m Files are overwritten each time logging begins.
= Only enabled results and statistics are logged.

o Automation Interface has been changed to a .NET model. This is a
breaking change and will require automation clients written for 1.x to be
rewritten. A C# example has been added.

o Data File extension is now .bwData. BeamWatch is backward compatible
and can still read .Ibd files. When they are opened they are converted to
.bwData files.

o Charts have been removed.
o Removed measured Beam Width Window

o Operator interface removed

Section 2 - Errata and Workarounds

We work hard to find and correct any issues in this software product. However, as of
this release we still have a few issues for which we have not found complete
solutions.

e An issue has been identified for version v3.40 or later versions where
localizations that use double-byte character sets cannot be used in the setup or
data filenames or it will cause the application to crash. This is due to a
limitation with a third-party component and includes languages such as
Chinese, Japanese and Korean. This could not be fixed by the release date of
this version. If this is a breaking change for a user, we recommend using v3.3.1.
This version may be obtained by contacting our Service team at
service.ophir.usa@mbksinst.com.

¢ Due to a technical issue with file handling in BeamWatch v3.40 and later, a
bwData data file cannot be opened by double-clicking it. Until this is fixed we
recommend opening data files through the File->Open menu item or via drag-
and-drop.



e Overwriting an existing log file while playing a data file is not possible. An
overwrite window will appear and ask to overwrite, but the file playback will
stop.

¢ Once a View window has been undocked, using the Views menu item to hide
and show the window will typically result in improper drawing of the window.
This can be corrected by either right-clicking the title bar of the undocked
window and selecting Dock; or by using the Reset Layout option in the Options
menu, accessed via the File Menu icon.

Section 3 - BeamWatch Notes

Supported Operating Systems

e Windows 10 (64-bit)

Documentation

e A PDF version of the User Guide is included with the installation. Adobe
Acrobat Reader is suggested to view this file.

Installation

e |t is recommended that all users are fully updated to the latest Windows
Updates. If all updates are not applied to your system this may cause problems
with the BeamWatch software.

e You must have Administrator privileges in order to install BeamWatch and the
required driver package.

e Because of the continual evolution of our camera supplier's driver interfaces
some incompatibilities between BeamWatch and earlier generations of OSI
software may be encountered. We recommend that if you have other OSI
software on your computer that you update all applications to their current
release.

Troubleshooting and Reporting Bugs

If you suspect you have found a bug in our software please help us identify it by
sending the following information to service.ophir.usa@mksinst.com.

1. A description of the actions that reproduce the problem.
2. The .bwSetup or .bwData file you were using at the time.

3. All files (if any) in the directory C:\ProgramData\Spiricon\BeamWatch\Logs.


mailto:service.ophir.usa@mksinst.com

4. All files (if any) in the directory C:\ProgramData\Spiricon\DataServer\Logs.

The more information you can provide, the more likely we can reproduce it in our
lab, and fix it.

* Ophir, BeamWatch and other products and software produced by MKS
Instruments, Inc. or one of its affiliates are trademarks of MKS Instruments or its
respective affiliates. The trademarks, trade names and service marks of other

companies appearing within the software and documentation are the property of
their respective owners.
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